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1 Overview

1.1 Setup

The setup consists of a computer with the PCap04 GUI installed. The computer connects using the
PicoProg USB - SPI/I2C interface which is then connected to the PCap motherboard. The PCap
motherboard serves as the host for the PCap04 evaluation board. The PCap04 evaluation board can
communicate via I12C or SPI. The elements of the set-up are illustrated below.

Figure 1:
Evaluation Board Setup

SPI

The ams GUI provides an easy to use interface to exercise the multiple options and features of the
PCap04.

1.2 Ordering Information

Ordering Code Description

PCAPO04-BQFN-24 PCap04
PCAPO4-EVA-KIT V1.0 PCap04 Eval-Kit
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2 Introduction

2.1 Preparation of Software and Hardware

211 Installing the Software

The software can be downloaded from www.ams.com/PCap04 and is a LabView based GUI that
enables full access to the chips register settings.

It is crucial to install the software before connecting the evaluation kit to your computer. It is possible
that a default driver configuration of your OS will interfere with correct installation.

° Download the latest zipped software installation package to the desired directory.
° Unzip the package to the desired directory.
° Open “setup.exe” from the unzipped directory.
° Follow the instructions on the screen.
2.1.2 Connecting the Hardware

° Connect your computer with the PICOPROG V3.0 using USB cable.
° Connect PICOPROG V3.0 and the evaluation kit motherboard using the DB15 interfaces
° Mount the plug-in board on the corresponding socket on the motherboard.

Application Note « PUBLIC
AN000568 « v1-00 » 2019-Apr-01 16 | 4


http://www.ams.com/Document-Feedback
http://ams.com
www.ams.com/PCap04

q m Document Feedback PCap04
Introduction
Figure 2:
Mother Board
* ocam mea";e;!romc GmbH
PCap01-MB V1.2
° Set the power supply unit to 7.5 V output.
° Connect the motherboard to power via the power supply unit. The green LED on the Eval kit
motherboard should be on.
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3 Eval Software vs. Assembler

3.1 Files Description

0 Information

Please do not make any changes in the system folder. Copy the system folder files to your private
folder for making changes if desired.

° .asm files are assembler files which contains the programming code.

° .dat files are the configuration files for Pcap04.

° .h files are headers containing the register descriptions of the device.
3.2 How to Handle Assembler Files

3.2.1 Load & Compile Existing Assembler Files
° Launch PCap04 eval software and select Assembler in Tools menu.

Figure 3:
Tools Menu

e e ———
B ams PCapl4

File Memaory Interface  Help

Setup  COCF Run Measurement Ctrl+R

Graph Ctrl+G
Registers Ctri+F
Linearize Ctrl+L

g Azsembler Ctrl+ A

° Next, go to open in File menu
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Figure 4:
File Menu

@ Assembler - ChProgram Files (x36

Edit Find Assembler Help
Mew Ctrl+M

Open Ctrl+C

° As an example, select PCap04_standard_v1.1.asm file click OK to load it.
For sure, you can choose here another assembler file.

Figure 5:
Assembler File

[ Open Assembler-File it
“ v <« ams * PCapl4 » Examples * PCap{d_standard_v1 v O Search PCap04_standard_v1 2
Organize = Mew folder == ~ [H 0
* Downloads ” Mame Date modified Type
d Music [ 7] pcaptd_standard_v1.asm 07.06.2016 10:31 ASM Source File
[&=] Pictures
B Vvideos
a2 .
i Local Disk (C:)
LU >
File name: v| |asm-FiIe: Header-File (*.asm; ™. V|
[ ok ] Coneel

After this, you should see the PCap04standard assembler source code.

Application Note « PUBLIC
AN000568 « v1-00 » 2019-Apr-01 16| 7


http://www.ams.com/Document-Feedback
http://ams.com

Document Feedback PCap04
Eval Software vs. Assembler

Figure 6 :
Assembler Source Code

B Assembler - C\Program Files (x86)\ams\PCap0d\Examples\PCap(4_standard_v1\PCap04_standard_v1.asm — O e
File Edit Find Assembler Help
NEHREES 0 %@’ B9
PCapl4_standard_vl.asm
1 et ~
2 ; File: PCap@4_standard_vXX.asm
3 ; Description:
4
5 This is the standard firmware that translates the TDC Start and TDC Stop values into
6 CDC and RDC wvalues.
7 3 Further depending on the configuration, the Capacitance and Resistance ratios are
8 ; calculated. From 9 possible results, 8 results are given out in the Result register RES@....7.
9 ; Pre-requisite : The Resistance Ratios can be calculated for Internal or External sensor
18 and Internal or External Reference. However, for this firmware, following
11 ; should be ensured.
12 PT@ - External Sensor or External Reference
13 H PT1 - External Sensor ONLY
14 Internal or External Reference ought to be selected in the R_PORT_EN_IREF
15 ; bit of Configuration Register 23.
16 Outputs:
17 RES@ .... 5 : Capacitance Ratiocs for Capacitance Ports PC@..... 5
18 RES6E : Resistance Ratio for External Sensor at Port PT1, w.r.t. Internal or External reference
19 H RES7 : Resistance Ratio for Internal sensor, w.r.t. Internal or External reference
22 PULSE® & PULSEL : Pulse Outputs
21 H
22 H
23 H Date : @8.84.2016
24 ;  Author: VK/OH
25 et
26
27  #device PCap@4vl
28
29  CONST FPP_CRATIO 27 ; FPP of the Capacitance Ratios result
38  CONST FPP_RRATIO 25 ; FPP of the Resistance Ratios result
31  CONST C_REF_PORT_NUMBER a 3 Port number of the reference Capacitance port (@....6 for Gr¢
32
33 j--------------------- Addresses in the NVRAM --------------mmmmmmmoooo
34  CONST NV_PULSE®_CAL el ; Address of calibration values for pulse@ output of capacitan:
35 CONST NV PIHISET ral MV PIISFA (A1 & 19 -+ Address af caliheation wvaluss Far nnlzal aobnot of canacitan:
£ >
Output

Most of the command lines already commented in green for better understanding.

° To Compile and run this code go to Compile in the Assembler.

Figure 7:
Assembler Menu

Help

Compile F5
Compile Options  Ctrl+F5
Download Fe&
Assembler Info

The compiled code will be automatically downloaded to PCap04.
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Figure 8 :
Downloaded Output

PCap04
Eval Software vs. Assembler

<

Qutput

INFO: Program Size: 548 Byte

Download successfull

INFO: C:\Program Files (x86)\ams\PCap@4\Examples\PCap@4_standard_v1\PCap@4_standard_vl.asm: Processing was successful

° RUNBIT needs to be enable before a measurement can be started.

Figure 9:
Enabling RUNBIT

] ams PCapld - X
File Memory Tools Interfface Help
Setup CDCFrontend CDC RDC PDM/PWM  DSP/GPIO  Misc Expert am% %"g
HE
General  €DC TDC Linearize
Open Graph
Bandgap
; i x0 [186_PeRm BG_TRIM .
LJAUTO ) ) _ - 0 5 Write Config
3.2.2 Edit Assembler Files
Double click the #include files to show them on the menu tab.
Figure 10 :
Edit Assembler Files
4] Assembler - C:\Program Files (x86)\ams\PCap04\ PCap04_standard_v1\PCap04_standard_v1.asm - a X

File Edit Find Assembler Help

PCap04_standard_vl.asm std dispatch.asm
119
12@ e e

121
122 MK_main:

The pcap_standard.h header file contains major address mappings and names for the PCap04. This
file should be always included. With the help of the code comments in green, you should be able to
edit the code for your own. Alternatively, it is possible to edit existing code samples.

Therefor select Examples in the Help menu.
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Figure 11:
Help Menu

P Assembler - C:\Program Files (x86)\ams\PCap04\Exam
File Edit Find Assembler

D Ii n E E’. EE Help Contents F1

Opcode Help F2
E Examples F4

About F12

PCap04_standard_vl.asm

Figure 12 :
Examples of Linearize and Standard Firmware
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Here you can select the linearized example code as well as the standard firmware load.

Examples
] P

Select Example

PCap04 Standard Firmware
®

Description

The PCapl4 standard firmware provides capacitance and
temperature measurement results as raw ratio. Thereby, the
firmware considers the configuration settings and delivers the
results accordingly. The following modes/features are
supported [not exhaustive):

* Capacitance ratio (C_ratio)

s Temperature (R_ratio)

* Pulse output (PWM/PDNM)

* Stray compensation

Result registers (see comments in header):

RESD ... 5 : Capacitance Ratios for Capacitance Ports PC0.. 5
RES6: Resistance Ratio for External Sensor at Port PT1, wort
Internal or External reference

REST: Resistance Ratio for Internal sensor, w.r.t Internal or
External reference

PULSED & PULSEL: Pulse Quiputs

PCap04 Linearize Firmware
O

Description

The PCapl4 linearization firmware helps to linearize a sensor
by capturing the inverted capacitance ratios at several points to
apply then a poelynomial (3rd order) correction. Similarly, the
temperature sensor's nen-linearity can be compensated. For
given coefficients, a two-point calibration can be performed.
The following features are supported (not exhaustive):

& Inverted capacitance ratio (ci_out)

* Temperature (r_out)

# Final result with correction (Z-result)

& Pulse output with correction (Pulse_Z)

Result registers (excerpt, full set see comments in header):
RESD: Z-result

RES1: theta

RES2: ci_out

RES3: r_out

RESE: Pulse_Z

Cancel

We recommend choosing one of these examples for your project. After that, you can easily customize
the code to your needs.

0 Information

You can get an overview of the standard Opcode commands in the help menu.

This can be found under “Opcode Help” in the “Help” menu
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Figure 13:
Opcode Help

B Assembler - C\Program Files (x28)\ams\PCap04\Exam
File Edit Find Assembler

— X Help Contents F1
D@EHES

PCapl4_standard_vl.asm == F4
R S, About F12
- 211a. Araeaa 1
Figure 14 :

Opcode Overview

PCap04

Eval Software vs. Assembler

£ Opcode Help — O *
- a6
Hide  Eack  Prnt  Options
Gorterds | lgex| Seerch Opcode Overview ~
Type in the word(s) to search for:
|| V| > Simple Arithmetic Miscellansous RAM access Bitwise operation
List Topics Display
Select topic: Found: D * a.‘;d * —reset‘ug[]i ; * % * H—UL
o Lontion ok * sign + powerOnRese » clear e and
« sub + nop + load . or
. inc « stop « |oad2exp . xor
* move
= push
Complex Shift operation Unconditional Bitwise
Arithmetic jump
« shiftlL s bitC
S » shifiR * goto . bitS
s mult * jsb
. it
Conditional Jump
. jcd
s |CarC
e CarS
= [EQ
« INE
= JNeg
jOfiC
[] Search previous results : OIS
Match similar words l_
[ Search titles only * POS v
@ For further information, please refer to the following documents:
° Device specific Opcodes can be found in the PCap04 datasheet.
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4 Store Your Code Permanently

Finally, you can store permanently your firmware in the non-volatile flash memory.

@ Warning

You have to power PCap04 with at least 3.0V for this operation.
Under voltage during flashing the device can permanently damage PCap04 !

Follow these steps to accomplish this:

° Compile and download your code
° Switch to main window and go to Firmware in Memory menu.
Figure 15:

Memory Menu

Bl ams PCapd
File Tools  Interface Help

Satl Firmware Ctrl+M |IPWM Ds

Calibration
Read Config from MVRAM

° Then push “Store” button in the “Complete Memory” tab

Application Note « PUBLIC
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Figure 16 :

Complete Memory Tab

Document Feedback

PCap04

Store Your Code Permanently

Bl Memory - X
Firmware  Calibration  Misc. Calibration @
Write Memory
(] ‘ 24 |5 ||Ae j|el || 20 |55 ||42 ||5C [|48 ||B1 o7 ||92 ||e2 || 20 |13 |je2
16 20 ||93 [|le2 IB2 [|02 || 78 || 20 ||54 |B3 ||06 || 91 |00 || 7F || 20 || 86 || 20
32 :54860372622054370006425CA10049BO
148 e |49 ||40 [|AB ||5D [|92 |1C ||90 ||e2 || 7F || 20 || 86 ||66 ||67 || 76 || 77
64 66 | 7A|ICF ICD ||E6 [|143 ||F1 |44 129 |[E@ || 7A ||DC JE7 |41 || 32 [ AA
30 01 ||99 |IFD |78 ||@1 | 7A JICF JEB J|EG ||43 |F1 [|44 [|29 €@ || 7A JIC1
96 E7 ||41 ||32 ||6A ||DE [|44 || 7A ||CF JIEA ||E6 |43 ||F1 [|44 || 29 ||E@ ||6A
112 | JDF {44 ||7A | C4 [[E7 |41 |{32 || AB {05 || 7A || C1 |[E1 |43 [[EQ || 3A | 7A
Read Memory Data equal Q
e 20 |00 |00 |00 |00 |00 ||@0 |00 00 |00 @0 |20 |00 00 | 00 00
16 @0 oo |00 | oo |oe |00 ||eo |0 |oo |00 | eo |oe ||co | eo oo oo
32 e |ee |eo |ee 0o | 0o |00 |00 |00 | oo e 6o 0o oo ||ee | ee
|48 | |oe|eo |ee|eo oo | oo | oo |0 oo |ce | ee | e | ee | oo | 0o |eo
64 00 ||eo | oo | oo ||oo | oo ||eo |00 |0 | e |0 | oo | oo oo | oo | oo
80 00 |00 |00 |eo |0 | eo |00 | oo | oo |eo | e | oo | oo | 6o ||oo |ee
96 00 ||eo |oo | oo | ee || oo ||eo |0 |00 |0 |0 | ee | e |00 | e | oo
112 | |ee |jee |00 oo |ee | oo | oo | oo ||ea | 0o | oo |ee || 0o | 0o | oo |00
| Read ] | Recall
Now your new compiled firmware is permanently stored in the NVRAM.
Test your operation by power cycling the device
° Click the “Power On Reset” Button in the main screen to enable power cycling.
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Figure 17 :
Expert Menu

PCap04
Store Your Code Permanently

General | CDC TDC Linearize

[ ams PCapl4 — ¥
File Memory Tools Interface Help
- B B
Setup CDCFrontend CDC RDC  PDM/PWM  DSP/GPIO  Misc Expert ﬁ ﬁ E
i H

Open Graph

Bandgap
Bruneim MEM_LOCK
x0 [86_perm BG_TRIM
[ JAUTOSTART | = s e —
DSP_TRIG_BG
12t A00 WD_DIS bAipss_Thic, BG_TIME
(00 [~ o] |xsa OINT_TRIG_BG |m |
[ EN_asYNC_RD
° Now your measurements can be started without compiling and downloading.
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5 Revision Information

Changes from previous version to current revision v1-00

Initial version
° Page and figure numbers for the previous version may differ from page and figure numbers in the current revision.
° Correction of typographical errors is not explicitly mentioned.

Application Note « PUBLIC
AN000568 = v1-00 * 2019-Apr-01 16 | 15


http://www.ams.com/Document-Feedback
http://ams.com

Document Feedback PCap04
Legal Information

6 Legal Information

Copyrights & Disclaimer

Copyright ams AG, Tobelbader Strasse 30, 8141 Premstaetten, Austria-Europe. Trademarks Registered. All rights reserved.
The material herein may not be reproduced, adapted, merged, translated, stored, or used without the prior written consent of the
copyright owner.

Information in this document is believed to be accurate and reliable. However, ams AG does not give any representations or
warranties, expressed or implied, as to the accuracy or completeness of such information and shall have no liability for the
consequences of use of such information.

Applications that are described herein are for illustrative purposes only. ams AG makes no representation or warranty that such
applications will be appropriate for the specified use without further testing or modification. ams AG takes no responsibility for
the design, operation and testing of the applications and end-products as well as assistance with the applications or end-product
designs when using ams AG products. ams AG is not liable for the suitability and fit of ams AG products in applications and
end-products planned.

ams AG shall not be liable to recipient or any third party for any damages, including but not limited to personal injury, property
damage, loss of profits, loss of use, interruption of business or indirect, special, incidental or consequential damages, of any
kind, in connection with or arising out of the furnishing, performance or use of the technical data or applications described
herein. No obligation or liability to recipient or any third party shall arise or flow out of ams AG rendering of technical or other
services.

ams AG reserves the right to change information in this document at any time and without notice.

RoHS Compliant & ams Green Statement

RoHS Compliant: The term RoHS compliant means that ams AG products fully comply with current RoHS directives. Our
semiconductor products do not contain any chemicals for all 6 substance categories, including the requirement that lead not
exceed 0.1% by weight in homogeneous materials. Where designed to be soldered at high temperatures, RoOHS compliant
products are suitable for use in specified lead-free processes.

ams Green (RoHS compliant and no Sh/Br): ams Green defines that in addition to RoHS compliance, our products are free of
Bromine (Br) and Antimony (Sbh) based flame retardants (Br or Sb do not exceed 0.1% by weight in homogeneous material).

Important Information: The information provided in this statement represents ams AG knowledge and belief as of the date that
it is provided. ams AG bases its knowledge and belief on information provided by third parties, and makes no representation or
warranty as to the accuracy of such information. Efforts are underway to better integrate information from third parties. ams AG
has taken and continues to take reasonable steps to provide representative and accurate information but may not have
conducted destructive testing or chemical analysis on incoming materials and chemicals. ams AG and ams AG suppliers
consider certain information to be proprietary, and thus CAS numbers and other limited information may not be available for

release.

Headquarters Please visit our website at www.ams.com

ams AG Buy our products or get free samples online at www.ams.com/Products
Tobelbader Strasse 30 Technical Support is available at www.ams.com/Technical-Support

8141 Premstaetten Provide feedback about this document at www.ams.com/Document-Feedback
Austria, Europe For sales offices, distributors and representatives go to www.ams.com/Contact
Tel: +43 (0) 3136 500 0 For further information and requests, e-mail us at ams_sales@ams.com
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